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CARTA on the Working with

ALMA Science Archive CARTA on your computer
e No need to install CARTA e Can customise panels and preferences
e No need to download data e Data must be downloaded locally
e Can open multiple images e Can open multiple images
e Can save work in PNG format (not FITS) e Can save work in FITS & PNG formats
e May get disconnected e Does not time out
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Using CARTA on the archive

e Go to the ALMA Science Archive: https://almascience.eso.org/aq/
e Query for Member ous ID: uid://AQO1/X87d/Xb3d
o Alternatively, query for project ID: 2016.1.00229.S
frequency range: 219 to 220 GHz
Select the one observation that is returned and click on Explore & Download button
e Click on the CARTA button next to the continuum file
member.uid___AO01_X87d_Xb3d.TW_Hya_sci.spw19_23_25_27_29.cont.I.pbcor.fits
e Click on the CARTA button next to the cube corresponding to spw 27
member.uid___AO01_X87d_Xb3d.TW_Hya_sci.spw27.cube.l.pbcor.fits

e You now have two CARTA sessions open (one for the continuum, one for the line cube)
You can append the line cube image in the continuum session and work in one session
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https://almascience.eso.org/aq/
uid://A001/X87d/Xb3d

Using CARTA on the Allegro computers

e Open a CARTA session on the Allegro machine assigned to you, following the
instructions in the User’s Guide

& File Browser (7]

C . |Q)> allegrol > allegro > home > YyOUr username

Filename Type Size .= Date File Information ~ Header

@8 open_ALMA_DRT2023 4 items 31 0ct 2023

EUROPEAN ARC
LM ALMA Regional Centre || Allegro

X



Using CARTA on the Allegro computers

e You can use two different datasets:
o The results of the tutorial work today:
m Continuum file: sis14_twhya_cont.image
m Append the line cube we created in the imaging session: twhya_n2hp.image

o A different TWhya dataset with higher spectral resolution in the archive folder
m Load the continuum file: TWhya_2016.1.00229.S_cont.fits
m Append the line cube: TWhya_2016.1.00229.S_C180.fits

> cp -r ../../archive/DRT2023/TW_hydra/*.fits analysis_tools/.

LyI will be using this higher resolution dataset in the demo today

' e If you prefer to work on your laptop and have CARTA installed, you can
» [T download the data at https:/bit.ly/AllegroDRT23-data
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https://bit.ly/AllegroDRT23-data

Live Demo + tutorial

1.Open CARTA
2.0pen the continuum file

3. Append the line cube
4.Change the layout: View > Layouts > Existing Layouts > Cube Analysis

5.Match the coordinate systems in the Image List tab
6. Select the continuum image, switch the viewer to single panel if it is
in multi panel, and play with how it is displayed using Render

Configuration tab
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Live Demo + tutorial

7.Create a region excluding the main continuum source and rename it ‘noise’
-> Get an estimate for the noise in the continuum image
-> Get an estimate for the noise in the cube (explore how the noise varies
in different channels using the Animator tab)
8. Delete the ‘noise’ region (select region & click delete or back button)
9.Create a new region covering the central area where there is emission and
rename this new region ‘disk’
10. Select the line cube in the image list tab and make sure the cube and
‘disk’ region are selected in the Spectral Profiler widget #
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Live Demo + tutorial

11. Play with the Spectral Profiler:
-> zoom in to regions of the spectrum where there is a line
-> click on parts of the line to see the image of that channel
-> Use the Animator to go through the channel maps of the line cube
12. Make moment O, 1, and 8 maps covering the line of interest (remember to match their

coordinates to the reference continuum image)
-> Play with excluding emission levels below a certain threshold (e.g. 3 sigma)

using the noise estimate from before
13. Create contours for the continuum and moment 1 image using two different colours

and save the image as a figure
-> Modify the look of the figure by clicking File > Preferences, as

Q /\ well as the settings wheel at the top of the viewer
\'\— EUROPEAN ARC
LASVEM  ALMA Regional Centre || Allegro



Live Demo + tutorial

14. Create two new regions:
-> One covering the redshifted emission, rename it ‘red’
-> One covering the redshifted emission, rename it ‘blue’
15. Visualise the emission over the three regions (red, blue, disk) in the Spectral Profiler by
ticking the ‘Region’ box at the top and selecting the regions
-> Play with the different statistics shown
16. Fit the emission line profile of the redshifted emission and the blueshifted emission with
Gaussian profiles (note the central velocities)
17. Save a new sub-cube (both spatial and spectral) that only includes the disk region and the
line of interest as a new FITS file

18. Append this new smaller cube & create a PV diagram for a cut across the strongest velocity
gradient

-> Remember that you first need to create a line region across the gradient
EUROPEA;F\
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% CARTA Usage Data

CARTA would like to collect anonymous usage data, in order to help the
development team prioritize additional features and platforms. No
personal or scientific information will be collected. Please see our data
collection policy for more details.

Yes, send usage data No, do not send usage data

Metrics include session duration, Only an anonymous opt-out
number and size of images opened. message will be submitted.
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TWhya_2016.1.00229.S_C180.fits.moment.weighted_cool C]

AW N o O

TWhya_2016.1.00229.S_C180.fits.moment.maximum Close

e e
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Open Image alt + O 2180.fits.moment.weighted_coord
R T T ™
Append Image  alt+L @ Sl ~ -
Save Image alt+S : o
Close Image alt+wW 1
Import Regions :
4 2
Export Regions «
Import Catalog alt+ G 3
T 2
Export Image > Resolution | €
x
— «©
Normal (100%) alt+E R
Open Workspace 7
High (200%) b
Save Workspace 4
Highest (400%) _
Preferences T S
Server > g
NSS! ]
P O N S N M B | . I ]
52.4 52.2 11:01:52.0 51.8 51.6 51.4 51.2
Right ascension
Animator X || Render Configuration X || Region List X || Image List X
Image Layers Matching Channel
0 TWhya_2016.1.00229.S_cont.fits R x¥J(R) 0
1 TWhya_2016.1.00229.S_C180fits R XY R 949
2 TWhya_2016.1.00229.S_C180.fits.moment.integrated R XY R 0
3 TWhya_2016.1.00229.S_C180.fits.moment.weighted_cooi R XY R o
4 TWhya_2016.1.00229.S_C180.fits.moment.maximum R XY R 0

Z Profile X

Image

1.40e+1
1.20e+1
1.00e+1
8.00e+0
6.00e+0
4.00e+0
2.00e+0
0.00e+0

Value (Jy/beam)

-2.00e+0

# QP 0O F O # S A °

1: TWh... ~ Region disk ~ Statistic  Sum ~ Polarization

219.552 219.554 219.556 219.558 219.56 219.562

[LSRK] Frequency (GHz)

Data: (219.5580984 GHz, 1.39e+l)

Statistics: Image (Active) X

Image = Active $ Region Active $ s
Statistic Value

NumPixels 6.100000000000e+2 pixel(s)
Sum 1.735089834929e+3 km/s
FluxDensity NaN

Mean 2.844409565457e+0 km/s
StdDev 2.511311759161e-1 km/s

Min 2.387814044952e+0 km/s
Max 3.311462163925e+0 km/s
Extrema 3.311462163925e+0 km/s
RMS 2.855456050313e+0 km/s
SumSq 4.973713845715e+3 (km/s)"~2
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TWhya_2016.1.00229.S_C180.fits.moment.weighted_cdord u[m D0 | ZProfile X o
T T T T T T T T — —— . i o o
gL 2 ~ - Image 1: TWh... ~ Region  diskre... ¥ Statistic Sum ¥ Polarization
| I
s | @ 1.40e+1
<l i _ 1.20e+1 Cursor
- £ 1.00e+1 )
8 8.00e+0 v disk
r T >
1o 3 6.00e+0
© «® S 4.00e+0 V/ red
- [ - (]
= L 1 > 2.00e+0 < blue
K] N 0.00e+0 F:F&#—ﬁ%j-ﬂa :
8 | 1 %’ -2.00e+0 =
= N 1 i x
§ oL | 43 219.554 219.555 219.556 219.557 219.558 219.559 219.56
[ b [LSRK] Frequency (GHz)
8 - - . Data: (219.5580984 GHz, 1.39e+l), TWhya 2016.1.00229.S_C180.fits, disk, Statistic Sum, Coordinate Current
# = — M pata: (219.5580984 GHz, 1.69e+0), TWhya 2016.1.00229.S_C180.fits, red, Statistic Sum, Coordinate Current
g. r b © . Data: (219.5580984 GHz, 1.38e+l), TWhya 2016.1.00229.S_C180.fits, blue, Statistic Sum, Coordinate Current
o
L i Statistics: blue (Active) X
[\ - —
T @ | Image = Active & Region Active s
Lo Ly S , N | By Statistic Value
52.4 5.2 11:01:52.0 51.8 51.6 51.4 51.2
. . NumPixels 2.660000000000e+2 pixel(s)
Right ascension
Sum 8.224154417515e+2 km/s
Animator X Renddr Configuration X | Region List X | Image List X FluxDensity  NaN
ok © / Name Type Center Size P.A. (deg) Mean 3.091787375006e+0 km/s
Cursor Point 1;214211‘;57 0.0 StdDev 1.028916484311e-1 km/s
- Min 2.835080862045e+0 km/s
A disk Ellinse 11:01:51.8029072828  5.9841688654" 00
x P -34:42:17.3958416686 5.8644854881" : Max 3.311462163925e+0 km/s
A reg Polvaon 11:01:51.7761079873  3.7017391319" 00 Extrema 3.311462163925e+0 km/s
= @ v -34:42:16.7216518372 | 3.5869565226" - RMS 3.0934925385066+0 kim/s
11:01:51.8284661460  3.5582608717"
& % A blue Polygon 0.0 sumsq 2.545539158821e+3 (km/s)"2

-34:42:17.9412173318 3.5008695660"
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TWhya_2016.1.00229.S_C180.fits.moment.weighted_coord [ Z Profile X
T T T T T T T T T T — o
o ) ~ %I Image 1: TWh... ~ Region diskre... ~
3 Z Profile Settings: Region #2 O X
3 [
L Conversion  Styling “Zmoothing Moments  Fitting
@ ; Line color (disk) _ s
S |-
§ r | Line color (red) [ E
B ol
a | Line color (blue) o
ol
3 L Line width (px) 1 :
P
3t
r Point size (px)
ol
L @ Show mean/RMS
Lo 0 0 o I 0 o o N m o [l | i Only visible in single profile
52.4 52.2 11:01:52.0 51.8 51.6
Right ascension Line style B L
Animator X || Render Configuration X | Region List X | Image List X
" X min 219.553499520855
"0 Name Type Center Size
) 11:01:51.15
Cursor Point -34:42:17.7 X max 219.560935479346
11:01:51.8029072828 | 5.984168
& % A disk Ellipse o
w -34:42:17.3958416686 5.86448f . _2.8437348133849"
v 11:01:51.7761079873  3.701739
& KA red Polygon -34:4216.7216518372 358695
u 11:01:51.8284661460 3.55826( Y mMax 15.8247428862759
& S A blue Polygon -34:42:17.9412173318  3.50086¢

Reset range

£al
<>
Lva

Reset range

# S A

SunT=v Polarization

Statistic

219.557 219.558 219.56

.SRK] Frequency (GHz)

219.559

C180.fits, disk, Statistic Sum, Coordinate Current

C180.fits, red, Statistic Sum, Coordinate Current

C180.fits, blue, Statistic Sum, Coordinate Current
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TWhya_zo16.1.0022{z Profile Settings: Region #3 @ x | Z Profile x OO
-] :TWh... ~ Region blue ~ Statistic Sum ¥ Polarization Current
S Conversionw Smoothing Moments  Fitting
[ - 1.40e+1
r Coordinate Radio velocity (km/s) s 1.20e+1
< |
[ z 1.00e+1
L System LSRK s § 8.00e+0
r =
- 2 6.00e+0
- Intensity unit Jy/beam s 3
Sl —_— £ 4.00e+0
ﬁ |-
£ L Secondary info O 25T
9 o
= r 0.00e+0
I optionally convert the spectrum from . . , . ) . . 0
o . . .
g N frequency to Ve[oc]ty [LSRK] Radio velocity (km/s)
g. [ Data: (3.0853 km/s, 1.38e+l)
F | Statistics: blue (Active) X (7 ) ]
ﬁ [
L @ Image = Active $ | Region | Active & | Polarization ent $
Lo . Statistic Value
52.4 NumPixels 2.660000000000e+2 pixel(s)
_ Sum 8.224154417515e+2 km/s
Animator X || Rendg¢ FluxDensity ~ NaN
a8 © Name Mean 3.091787375006e+0 km/s
StdDev 1.028916484311e-1 km/s
Cursor
Min 2.835080862045e+0 km/s
:.: @ disk Max 3.311462163925e+0 km/s
Extrema 3.311462163925e+0 km/s
2O red
LI RMS 3.093492538506e+0 km/s
SumSq 2.545539158821e+3 (km/s)"2




[ Reset | Fit l viewiog I YOS

File View Widgets Help ® / OO0 ~F BN 4B 2OFH&»L S8 L2 Q@ 0O F = || &|n| fit spectrum with a °
TWhya_2016.’I.0022§" Z Profile Settings: Region #3 9 x | Z Profile x GaU531an funCtlon OO
est BB Conversion  Styling Smoothing  Moments  Fitting <— .| Image 1: TWh.. ~ Region blue ~ Statistic  Sum ~ Polarization Current
N J—
I Data source TWhya_2016.1.00229.S_cont fits S ol /
L 1.20e+1
Ir Profile function Gaussian %  1.00e+1 make sure to Only
H 3
[\
- 8 soen — Select ONE spectrum
L Auto detect K | (O w/cont., @ Autofit B 0.0 X i .
~ 6.00e+
e 3 (1.e. untick the Region,
c L S 4.00e+0 5
g detected 1 componert. choOse these for and select one region)
T X L. 2.00e+0
= = A
=l Components 1 2 automatic fitting N oo
° [ Center 3.0435606610395354 £ “k -6 -4 -2 0 2 4 8 10
qT [LSRK] Radio velocity (km/s)
G
Sl Amplitude 9.29203303665109 s 5 B e, sy
N r FWHM 0.41695972611731213 o By Statistics: blue (Active) X Q<O
“ - Image = Active $ | Region | Active & | Polarization ]
k @ Continuum None S
T Statistic Value
52.4 Fitting resuft NumPixels | 2.660000000000e+2 pixel(s)
| Component #1 Sum 8.224154417515e+2 km/s
Animator X || Rendg¢ Center = 3.113515 (km/s) FluxDensity ~ NaN
‘0 Nane Center Error = 0.002602 (0.084%) Mean 3.091787375006e+0 km/s
Amplitude = 13.537950 (Jy/beam) StdDev 1.028916484311e-1 km/s
Cursor Amplitude Error = 0.169440 (1.252%) e 2.835080862045¢+0 ks
ﬁ i FWHM = 0.423900 (km/s) . .
ax > disk FWHM Error = 0.006126 (1.445%) fdax 3.311462163925e+0 kmjs
E:? j Integral = 6.108698 (Jy/beam * km/s) Extrema 3.311462163925e+0 km/s
el el Integral Error -= 0.076456 (1.252%) RMS 3.093492638506e+0 km/s
“ :.: @ blue SumSq 2.545539158821e+3 (km/s)"2




File  View

TWhya_2016.’I.0022§‘ Z Profile Settings: Region #2

WCS: (11:01:5]
ﬁ =

Declination
16 14
T T

18
T

-34:42:20
T

22
T

Animator X || Rendg

‘ © Name
Cursor

»E A disk

& 3 A e

& 5K A blue

Widgets

Help

m /002~ H

S N R QP

Conversion

Data source

Profile function

Auto detect

Components

Center

Amplitude

FWHM

Continuum

Fitting result

| Z Profile X

@Blsoel« &lenl fit spectrum with a .
Gaussian function

Lol R gllm

=B &4 E D[
O x
Styling Smoothing Moments  Fitting 47
TWhya_2016.1.00229.S_cont.fits s
Gaussian
K (O w/cont.| @ Auto fit

detected 1 component. choose these for
1 2 automatic fitting

2.5432089897089534

LR

10.566931553543455 g | By

0.500351671344103 s

a

None >

Component #1

Center = 2.587613 (km/s)

Center Error = 0.004195 (0.162%)
Amplitude = 13.827553 (Jy/beam)
Amplitude Error = 0.233696 (1.690%)
FWHM = 0.506167 (km/s)

FWHM Error = 0.009878 (1.952%)
Integral = 7.450265 (Jy/beam * km/s)
Integral Error ~= 0.125915 (1.690%)

[ Reset | Fit l viewiog I YOS

Image 1: TWh... v Region

4

red v

1.40e+1
| 1221 make sure to only
£ 1.00e+
5; soes0 . S€lect ONE spectrum
3 soe0 (@, untick the Region,
S 4.00e+0 d lBct .
oo @Nd select one region)
0.00e+0 st SR P ,
-4 -2 0 2

Data: (-4.3366 km/s, -2.6le-1)

Statistics: blue (Active) X

Statistic

4
[LSRK] Radio velocity (km/s)

Sum ¥

Polarization Current

(2P gl

Image  Active $ | Region | Active & | Polarization ~
Statistic Value

NumPixels 2.660000000000e+2 pixel(s)
Sum 8.224154417515e+2 km/s
FluxDensity NaN

Mean 3.091787375006e+0 km/s
StdDev 1.028916484311e-1 km/s

Min 2.835080862045e+0 km/s
Max 3.311462163925e+0 km/s
Extrema 3.311462163925e+0 km/s
RMS 3.093492538506e+0 km/s
SumSq 2.545539158821e+3 (km/s)"2
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Open Image alt+0 | (2R gls

P 9 File Browser @ x
Append Image  alt+ L lation Current
Save Image alt+S ¥ o [ > Users » aida > Documents > Work > Leiden > Allegro > Events » 202311_Data_Reduction_Day > data
Close Image alt+Ww . .

. Filename Type Size Date Save Image  File Information  Header
Import Regions 114_twhya_cont.image CASA 303.7kB 9 Dec 2022 Source TWhya_2016.1.00229.S_C180 fits
A Vhya_2016.1.00229.5_C180fits FITS 11GB 9 Dec 2022
Export Regions .
| 1 | Vhya_2016.1.00229.5_C180_zoom.fits FITS 564.5 kB 9 Dec 2022 et disk (ELLIPSE) =
mport Catalog  alt+ G ypya 2016.1.00229.5_cont fits FITS 581.8 kB 9 Dec 2022
h 2hp.i CASA 3.9 MB 9 Dec 2022 ; A n

Export Image il S ec Range unit Radio velocity (km/s) s LSRK s
Open Workspace = v

P P Range from 0 (km/s)
Save Workspace 8 10

Range to 5 (km/s)

Preferences
Server > Rest frequency 219.560358 & GHzs$ @+ 0

o

o

@ Drop degenerate axes
TWhya_2016.1.00229.S_C180 fits FITS +
52.4
Animator X Re} SR [
Image Layers TT -

0 TWhya_2016.1.00229.5_cont.fits R xv)(’) 0 St‘dDev 2.885691060906e-2 Jy/beam

1 TWhya_2016.1.00229.5_C180.fits R Xy (Z) 949 Ul et 8C 08037898 03 e o By bean)

2 TWhya_2016.1.00229.S_C180.fits.moment.integrated R XY R 0 Max 8.747770637274e-2 Jylbeam

3 TWhya_2016.1.00229.S_C180.fits.moment.weighted_coord R XY R 0 Extrema 8.747770637274e-2 Jy/oeam

4 TWhya_2016.1.00229.S_C180.fits.moment.maximum R XY R 0 RMS 4.049917568488e-2 Jy/beam

SumSq

7.954888671103e-1 (Jy/beam)”2
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TWhya_2016.1.00229.S_C180.fits.moment.weighted_coord ! Z Profile >¢
e e s,y = o ey s e ey — T
o );_Imag NaN ;I J Image 5: TWh... ~ Region disk ¥ Statistic  Sum ~ Polarization
: PV Generator O £ X
s o
L Image (5: TWhya_2016.1.0... = 5: TWhya_2016.1.00229.S_C180_ ¢
e PV cut (line) line s
S |
© [ . A
£ | Average width 3 v m
B ©
Jo e
= r R a
| Coordinate Frequency (GHz) s 219.5595 219.56
- @
L System LSRK s
g. : &
L Range (GHz) From 219.5566! To 219.5603!
[\ .
N
r @ Axes order X-axis: Spatial, Y-axis: Spectral s
S O M. I .
52.4 52.2 11:01:52.0 51.8 51.6 q .
Keep previous PV image(s
Right ascension PP ge(s)
Animator X || Render Configuration X || Region List X || Image List X . . -
Preview region Image >
Image Layers
TWhya_2016.1.00229.5_cont.fits Preview rebin (px) XY 1 2z |1 2
TWhya_2016.1.00229.S_C180.fits
TWhya_2016.1.00229.S_C180.fits.moment.integrated Preview cube size (MB) 33.72

TWhya_2016.1.00229.S_C180.fits.moment.weighted_cool
TWhya_2016.1.00229.S_C180.fits.moment.maximum
TWhya_2016.1.00229.S_C180_zoom.fits

g s W N o O
D UV W DWW DD
(9]

Start Preview
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TWhya_2016.1.00229.S_C180_zoom_pv.fits

Image: (31, 30); NaN*

[LSRK] Radio velocity (km/s)

-3 2 -1 0
OFFSET (arcsec)

Animator Render Configuration Region List
Image

TWhya_2016.1.00229.S_cont.fits
TWhya_2016.1.00229.5_C180.fits
TWhya_2016.1.00229.S_C180.fits.moment.integrated
TWhya_2016.1.00229.S_C180.fits.moment.weighted_coord
TWhya_2016.1.00229.S_C180.fits.moment.maximum
TWhya_2016.1.00229.S_C180_zoom.fits
TWhya_2016.1.00229.S_C180_zoom_pv.fits

oo A W N o O

Image List X

Layers

'V VW VW VW VD
(]

2
Matching
xYJ(R)

XY R
XY R
XY R
XY R
XY 7
XY R

Channel

0
949

8L QY OO E SN °

Z Profile X

Image 5: TWh... ~ Region disk ~ Statistic  Sum ~ Polarization

1.40e+1
1.20e+1
1.00e+1
8.00e+0
6.00e+0
4.00e+0
2.00e+0
0.00e+0
-2.00e+0

Value (Jy/beam)

219.557 219.5575 219.558 219.5585 219.559 219.5595 219.56
[LSRK] Frequency (GHz)

Data: (219.557732 GHz, 2.64e+0)

Statistics: Image (Active) X

Image = Active $ Region Active ¢ s
Statistic Value

NumPixels 3.843000000000e+3 pixel(s)
Sum 1.670813238415e+1 Jy/beam
FluxDensity NaN

Mean 4.347679517082e-3 Jy/beam
StdDev 1.407896540495e-2 Jy/beam
Min -8.513540960848e-3 Jy/beam
Max 1.021177321672e-1 Jy/beam
Extrema 1.021177321672e-1 Jy/beam

RMS 1.473322793122e-2 Jy[/beam
SumSq 8.341923442648e-1 (Jy/beam)”2



